
Overview of InfoLink Link Checker
InfoLink Link Checker provides the resources needed to maintain one or more Web sites.

InfoLink provides four ways to verify links:    you can verify a single link at a time if you need to quickly 
check the validity of just one link, one page at a time to make sure that a new page just added to your 
site is working properly, a list of pages for those times that your whole site does not need to be checked, 
or your entire site for complete verification.

InfoLink can verify links in files on disk or from the Internet.    After the links have been checked, the 
results can be viewed in the InfoLink Browser.    Results are displayed in statistical list and HTML format 
for easy reading.    To view the HTML results, click the HTML button at the bottom of the browser.    To 
view statistics about the links in the page and information about the page verified, use the Page Links, 
Link Information, Page Information buttons.

There are a number of reports that are built after verification.    What you instruct InfoLink to verify 
determines the set of Verification Reports that are built.    Verification results will always be built and 
viewed in the InfoLink Browser.    To view these reports in an external browser, click the Open In Browser
button on the main screen.    

When verifying a site or Page List, InfoLink builds a complete set of Verification Reports. These are 
detailed reports with all the information needed to help locate and correct problems in the pages you 
need to manage.    These reports are viewed in the InfoLink Report Viewer and can also be opened in an
external browser.

To view information about a visited page, use the Document Information option in the View menu.

Information about each page verified is stored in an InfoLink Edit File (".ief").    These files can be found 
in the application's Cache directory.    Each file holds information which allows you to edit the broken 
links with the InfoLink Editor.    The Results List Window manages this information.    To open an InfoLink 
Edit File, use the View|Results List menu in the InfoLink Editor.    This opens the Results List window, 
then simply drag and drop a page on the editor.

Use the Site List Manager to store information about any number of sites you need to maintain.    If 
needed, multiple Site List Files, one for each site you need to maintain, can be created.    

If you have a set of pages you manage, you should use the Page List Manager.    Multiple Page List Files
can be created for different sets of pages.

After you verify a complete site, you can view the structure of that site with the Tree View window.    

The Broken Link Analysis window displays an explorer-style view of all broken links found after verifying 
a Page List or site.

At any time you can view each page that has been visited and links that have been checked with the 
URL Information Window.

To view the most recent result page after the contents of the browser change, click the View|Previous 
Results, and to view the most recent collection of Page List Results, use the View|Previous Page 
Results List menu option.    This list will remain until a new set of pages has been verified.

After a site or Page List has been checked, the results are displayed in a list box under the appropriate 
Errors or No Errors tab.    To view page results, select the result file you want to view and click the View|
View Results menu option.    The buttons at the bottom of the page results list can be used to scroll 
through each result page.



Change InfoLink options by going to the General, Network, or Verification Preferences windows from the 
Options menu.

To find address, host, service, or port information, use the InfoLink Lookup feature.

The History List maintains a list of all pages that have been visited.

Use the Command Line Parameters to do verification on start-up.    When using command line 
parameters, InfoLink will automatcially shut down after verification has finished.    This will allow InfoLink 
to be scheduled.    Once started, if you need InfoLink to not shut down, unchecking the option Exit After 
Page List Verification in the Options menu will keep InfoLink from closing.      If InfoLink closes 
automatically, when reopened, all Verification Reports can be reopened with the View|Previous Results 
List option and the InfoLink Report Viewer.



InfoLink Browser
The InfoLink Browser is provided for the sole purpose of simplifying your link-checking process.

HTML pages are displayed and links are active so you can browse from page to page.    This allows you 
to start at a certain home page, verify the links,    and continue as needed.    It also provides an excellent 
interface for viewing results.

The browser can be very helpful in checking the validity of results.    For example, when results are 
returned showing a link to be broken, you can jump to that location from the browser and see what it 
displays.

InfoLink will browse to any normal HTML page.    However, moved links will not be redirected to the new 
location.    Usually when a page has moved, the server will return a page with an active link pointing to a 
new location.    In some cases this information is not returned.    If a page is not returned that shows the 
new location, you can use the Document Information option in the View menu to view the Page Headers
returned from the server.    The new location should be listed.    Double clicking on the moved location will
open that page in the browser.

The browser does support forms.    However, with the InfoLink Browser you should NEVER send critical 
data of any kind.    The support for forms was added for sites such as Yahoo and WebCrawler for 
searching and for sites that have their links within the <OPTION> tag of a form.    When browsing this 
way, a page may be returned informing you that the browser you are using sent a request that was not 
understood by the server.    If you see this or a similiar message, you can click the Location button and 
the page will then load normally.

InfoLink does not display graphics found in HTML documents.    Also, the InfoLink browser will not jump 
to locations that do not appear to be HTML pages.

The information displayed in the browser can be saved to disk or printed for later use.



Overview of the InfoLink Editor
The InfoLink Editor is a simple editor that allows you to correct broken links that are found in your HTML 
pages.

The directory tree and file list allow for easy opening of existing files.    Right clicking on a file in the list 
will open a pop-up menu.    Selecting the Execute option will open the file in the default program.

To open an HTML page directly from the Web, use the Open From the Web option in the File menu.    If 
the page requires password access, you will be prompted to enter a username and password or to use 
the information supplied in the General Preferences.

To open a file, drag it from the editor file list or use the Open option under the File menu.    Any text file 
can be opened in the Editor.    If an InfoLink Edit File is opened, a dialog will prompt you to enter the 
location of the specifed file with the broken links.    The location can be on local disk or the Internet.    
Once entered, InfoLink will locate the file and display it in the Editor, and any broken links associated 
with that file will be listed in the Broken Links List.

Use the Editor to correct broken links after verification has finished.    All result information is stored in the
application's Cache directory.    This information can assist in locating and correcting any problem links in
your HTML files.

Files can be opened from the Windows Explorer by dragging the desired file and dropping it on the 
InfoLink Editor.    If the file is an HTML file, it will be opened as normal; if the file is an InfoLink Edit File 
(".ief"), InfoLink will recognize the file type and open it ready for broken link correction.

To open results after a page has been verified, use the Results List window.    This window can be 
opened from the Results List option under the View menu.    It can also be opened by clicking the button 
located at the bottom left corner of the editor.

To view how the HTML contents of the Editor will appear in a browser, choose the HTML in Browser 
option in the HTML Menu.    (This is also good for checking the hot spot of active links in your document 
after changes have been made.)

To open the current file in an external editor or browser, look under the HTML Menu.    To do this, you 
must have entered a valid browser and/or editor in the General Preferences window.    If one has not 
been specified, the preferences window will automatically open.

To check links in the current document, select the HTML|Check Links option.



Site List Manager
The Site List Manager allows you to manage any number of sites.    By adding sites to the list and setting
options for each, you can verify any listed site with just two mouse clicks.    Each site entry has options 
you can set to help quickly identify it and separate it from others when building Verification Reports and 
Verification Results.    As many Site List Files (*.slf) as needed can be created to separate sites into 
different levels.    These files are stored in the application's Files\SiteList directory.    See the Site List 
Manager Description for an example on using it.

To open the Site List Manager, use the Open Site List option in the Internet menu or click the Open List 
button on the Main screen, and a pop-up menu will be displayed.    Choosing the Open Site List option 
will perform the same action.

To add a new site to the list, use the Site List|New option.    A new entry will appear at the bottom of the 
site tree.    The right side of the window will have space provided to enter various options.    A description 
of each follows:

Title of Site
Defaults to - Enter a Title of Your Site Here
You should enter - A unique title of the site to help identify it in the tree.
Description - Identifies each site in the list.    Does not have to be unique.

Starting URL
Defaults to - Enter Your Starting URL Here
You should enter - The URL in which verification should start.    Usually your index page.
Description - The URL of the site from which InfoLink begins the site verification.    Does not have 
to be unique.

Automatically Start Verification When Finished
Defaults to - Checked
You should - Leave checked if you want InfoLink start verifying pages as soon as your site has 
been retrieved or uncheck if you only want a list of the pages in your site.    See the Page List 
Manager and Page List Manager Description for more information.
Description - Informs InfoLink that the site should or should not be downloaded then verified all at 
once.

Build Tree of the Site Being Verified
Defaults to - Checked
You should - Leave checked if you want InfoLink to build a tree to be displayed in the Tree View 
window or uncheck if no tree structure is needed.
Description - Informs InfoLink that a tree structure should or should not be built after verification 
has completed.

Save result files as
Defaults to - Enter_A_Unique_Result_File_Here
You should enter - A unique file name under which you want InfoLink to save your result files and 
reports.
Description - This file name is use to save your results.    Each result file will be in the format of 
"filename##".    The file name entered will also be the report name InfoLink uses to create your Site
Reports.    For example, if the name entered is BiggByte, the main Site Report will be called 
"BiggByte.htm" and stored in the application's Reports directory.    A Changed Link Index (".scf") 
file will also be created using the file name you enter here.    You may change it at any time;    
however, it is recommended that you try to not change the name unless neccessary.



With this extension (.htm or .html)
Defaults to - .htm
You should - Specify your preference of the result file extension.    The extension must be selected
here.    The space provided for the file name will not accept file extensions.
Description - This identifies the extension to use for Verification Results only.    All Site Reports 
built will end with the .htm extension.

Save my sites pages as this Page List
Defaults to - Unchecked
You should - Check if you want InfoLink to save all the pages found in your site to a Page List.    If 
checked, you will need to enter a file name (with the extension ".htm" or ".html") in the space 
provided.
Description - This informs InfoLink to save the pages found in your site to a Page List.    If this 
option is checked, you should enter a filename in the space provided.    The Page List will be 
created and saved to disk in the application's Files\SiteList directory.    This Page List can be used 
in the Page List Manager to create a new Page List item.    (See Page List Manager Description for 
more information.)    Also, after at least one site check, the Page List can be used to verify your 
whole site without searching for local pages.    This can greatly reduce overall verification time.    
(See the Site List Manager Description for more information.)    You should try to make this filename
Unique.    A good naming convention to use is to add the word "pages" to the filename.    For 
Example:    MySitePages.htm, BiggBytePages.htm.

Instead of downloading my site use this Page List
Defaults to - Unchecked
You should - Check if you have previously created a Page List of all pages in your site that need to
be verified.    If checked use the ellipsis button next to the space provided to select the Page List 
from the Files\PageList or Files\SiteList directories.
Description - Informs InfoLink that you already have a Page List with all the pages on your site in a
local disk file.    If this option is used, InfoLink will open the specified file and treat all the pages 
found as though they were downloaded from your site.    This can reduce overall verification time.    
It is recommended that this option be used as often as possible.    Once you have created a Page 
List of your site, you may want to add it to the Page List Manager.    Then you can maintain the 
Page List from there.    Simply delete and add pages from and to the file as your site changes.    To 
select a Page List to use for site verification, use the ellipsis button to open a dialog box listing of all
Page Lists found in the application's Files\PageList and Files\SiteList directories.    You can 
change the current directories as needed.    The Site List Manager does not maintain this option.    
Each time the program closes, all information for each site is saved except for this.

Changing Preferences
You may need to change program options before beginning the verification of a certain site.    To change 
preferences from the Site List Manager, use the Open Preferences button and select from the pop-up 
window the Preferences window that you wish to open.

Downloading and Verifying a Site
To verify a site in the tree, select the site you wish to download and/or verify, and click the start button.    
The size of your site and your connection speed will determine the length of time InfoLink will take to 
download and/or verify the site.    After verification has completed, InfoLink will build a set of Site Reports
that can be viewed in the InfoLink Report Viewer.    All Verification Results will be listed in the appropiate 
Errors and No Errors listbox on the Main screen.

Quickly Verifying a Site
Once all information has been entered for a site, you can use the Open List button on the Main screen to
verify a site with only two clicks of the mouse.    Clicking the Open List button displays a pop-up menu.    
Move the mouse over the "Verify Site..." option and the first ten sites listed in the current Site List File of
the Site List Manager will appear as a menu item.    Selecting a site from the menu list will automatically 



start processing that site.    The current options specified in the Site List Manager for that site will be 
used.

When the program closes, InfoLink stores all information about each site entry in the Site List Manager 
except for the information specified in the "Instead of downloading my site use this page list" option.



Page List Manager
The Page List Manager allows you to maintain any number of Web pages that need to be verified.    All 
information about your pages is stored in a Page List File (".plf").    These files are stored in the 
application's Files\PageList directory.    Each Page List File can maintain any number of Page List 
Groups.    Each Group can have any number of Page Lists within it.    A Page List is an actual HTML file 
that InfoLink creates and stores in the application's Files\PageList directory.    Each Page List can 
contain any number of links.    When verifying from the Page List Manager, you can verify a Group, Page 
List, a single page from a Page List, or links within a Page List.    (See the Page List Manager 
Description example for more information.)

To open the Page List Manager, use the Internet|Open Page List option from the Main screen.    Once 
you have added Groups and Page Lists to the Page List Manager, you can click the Open List button on 
the Main screen to quickly open the Page List Manager or select a Page List to verify.

When verifying pages in a Page List, a complete Page List, or a Page List Group, InfoLink will build a set
of Page List Reports after verification has completed.    These reports can be viewed in the InfoLink 
Report Viewer or in an external browser.    The reports are stored in the application's Reports directory.    
To view reports, open the InfoLink Report Viewer and select the Open Report option from the File menu. 
The report name will be an HTML file in the format of "ReportNamepl.htm".    The actual name of the 
report depends on the type of verification performed.    Report names are discussed in more detail below.

Managing The Page List
A Page List File maintains all information about the Page Groups and Page Lists you define.    There can 
be any number of Page List Files.    Each Page List File has information broken down into Page List 
Groups, Page Lists, and Page Links.    Don't confuse a Page List File with a Page List.    A Page List File 
contains all information about your Page Groups and Page Lists.    A Page List is an actual HTML file on 
disk that contains a list of URLs.    To create, open, or save a Page List File, use the File menu.

A Page List Group maintains a set of Page Lists.    A Page List Group is basically a title you give a set of 
pages you need to verify. To create a new Page List Group, use the Page List|New|Group menu option.   
A new group will appear in the tree called NewGroup(#).    A group can be renamed to any name you 
like.    You should rename groups to a unique name of your choice.    Each group contains the Page Lists 
that you add.

A Page List is an actual HTML file on disk that is stored in the application's Files\PageList directory.    In 
it is a list of URLs (pages you need to verify).    This file in generated by InfoLink and should not be edited
unless necessary.    To create a new Page List, select a Page Group from the tree.    Once the Group is 
selected, use the Page List|New|Page List option.    A new Page List named "NewPageList.htm" will 
appear as a child of the selected group.    This creates a file on disk called "NewPageList.htm".    It is 
recommended that you rename this file to another name.    This is done by clicking the Page List in the 
tree, then clicking it again to put it in edit mode.

To add an existing HTML file to a Page Group, select a Page Group from the tree.    Use the Add Page to
Group option in the Page List menu.    A dialog will appear prompting you to select an HTML file.    When 
you have selected an HTML file, the Page List Manager will open the file, and a Page List with all links 
found will be created and saved to the Files\PageList directory.    All links found in the file will be 
displayed in the contents window.    When adding a file to the Page List Manager, you may be prompted 
to enter a Base Link.    A Base Link MUST be entered.    This allows InfoLink to correctly interpret the 
relative links found in the HTML file.    (For more information, see Base Links.)

You can also add a Link List file to the Page List Manager.    A Link List file is a text file of links.    You can 
create a Link List file by right clicking the Links listbox on the Main screen and selecting the Save Links 
As... option.



To add links, select a Page List from the tree.    Choose the Add Link to Page List option in the Page List 
menu.    A dialog will appear prompting you for a URL or HTML file on disk.    Enter the address of the 
page you wish to add or use the ellipsis button to select an HTML file from disk.    The format of a URL 
should be "http://www.theurl.com/".    Click the OK button and the new link will be added to the list.    
When adding a disk file to a Page List, you may be prompted for a Base Link.    Only http, https, and 
local files are in a Page List.

You can move Page Lists and Page Links from one location to another by dragging and dropping them 
to another Page Group or Page List.

When a page is opened on the Main screen and the links from the file are listed in the listbox, you can 
right-click the mouse over the listbox and select the Create Page List option to quickly create a Page 
List.    InfoLink will create a new Page Group ("NewGroup(#)") and add to it a new Page List 
("NewPageList.htm") with all the links listed in the listbox.    When this is done you should rename the 
new information to unique names.    InfoLink will add ALL LINKS listed in the listbox, so you may need to
scan the new Page List for any links that are not HTML files.

When you have multiple Page List Files, be aware that a Page List can be used in more than one place.  
Always be sure that manipulating a Page List in one location doesn't affect its presence in another.

Verifying Links with the Page List Manager
When verifying links with the Page List Manager, you have a few different options.    Links within the 
Page List Manager can be treated as links in an HTML file or as pages from a site.    This allows you to 
check the validity of files like bookmark files while still allowing you to verify sets of pages from a site.

Verifying Links in a Page List
To verify the links found in a Page List, select the desired Page List from the tree.    All the links found in 
that Page List will appear in the contents window.    Of those links, select the ones you wish to verify and 
click the right mouse button.    When the pop-up menu appears, select the "Verify Selected Links" 
option.    This will check the validity of pages as links.    When verification has finished, a result page will 
be displayed in the InfoLink Browser.    This is useful for files such as bookmark files.    By adding such a 
file to the Page List Manager, you can quickly verify the links within it.

Verifying Pages in a Page List
To verify a set of pages, select a Page List from the tree.    Once all links appear in the contents window, 
select the pages you wish to verify.    When the pages are selected, right-click the mouse and select the 
"Check Selected Pages" option.    This will take the selected pages and verify all links found in each.    
When a set of pages is verified, a set of Page List Reports will be built and displayed in the InfoLink 
Report Viewer.    The report name will be the name of the selected Page List plus the letters "pl" to help 
distinguish between Site and Page List Reports.    For example:    If you have a Page List called 
biggbyte.htm, when verification has completed, the Page List Report will be called biggbytepl.htm and
stored in the application's Reports directory. If you wish to view the report later in the InfoLink Report 
Viewer or an external browser, you should open that file.

Verifying a Complete Page List
To verify a complete Page List, select the desired Page List from the tree.    From the Page List menu, 
click the "Verify this Page List" option.    InfoLink will find all pages within the selected Page List and 
verify all links in each.    When verification is finished, a set of Page List Reports will be built that can be 
viewed in the InfoLink Report Viewer.    The main report name of the reports will be the Page List File 
name plus the letters "pl".    See above for an example.

Verifying a Page List Group
To verify a Page List Group, select a group from the tree.    Click the "Verify this Group" option in the 
Page List menu.    This will open each Page List found in the group and find all pages in each.    InfoLink 
will then start verifying all links found in each page.    After verification has completed, InfoLink will build a



set of Page List Reports to be viewed in the InfoLink Report Viewer.    The report name will be the name 
of the Page List Group plus the letters "pl".    For example:    If you have a Page List Group named 
"MyGroup", the report name would be "MyGrouppl.htm".    If you want to open this set of reports later 
in the InfoLink Report Viewer or an external browser, you should open this file.



Tree View
The Tree View displays the tree structure of your site.    All pages found in the site are listed in the tree, 
and information associated with each page can be accessed through the Tree View.

When an item in the tree is selected, InfoLink will list information about that page in the Information tab 
of the Contents window, and all the links found in that page will be listed in the Links tab.    Each link 
listed will have the URL, status, and error if there is one displayed.    Each link is associated with a list of 
pages from which that link was found (parent links).    To view the parent or parents of a link, select it 
from the list of links, and all its parents will be listed in the Parent Links tab.    Each parent item in the list 
will display the URL and its HTML title.    Double-clicking on a link will also display the parents of that link.
Double clicking on a parent will return you back to the link list.

When viewing items in the tree, all links are displayed in the Contents window.    You may wish to view 
only broken links.    If so, in the Options menu, check the menu item "Show Only Broken links", and 
InfoLink will only display links which failed in verification in the Contents window.

Note:    This information is cleared each time a new site is retrieved or the program closes.



Broken Link Analysis
The Broken Link Analysis displays all pages that contained broken links.    

To see the broken links of a page, select a page from the tree list, and all broken links from that page will
appear in the Broken Links list.    The Broken Links list also contains various information about each 
broken link found (i.e. Broken Link, Error, Moved Location, Type...).

Only pages WITH BROKEN LINKS are displayed in the Broken Link Analysis.    To view all the links of 
each page, you should open the Tree View window.

This information can be printed or saved in HTML format.

This information is ONLY available when a set of pages have been verified - that is, when verifying a set 
of pages or a site from the Page List Manager or Site List Manager, respectively.

Note:    This information is cleared each time a new set of pages is verified or the program closes.



Viewing Results
When verifying a single link with the Quick Verification or only one page at time, InfoLink builds a result 
file and displays it in the InfoLink Browser along with information on the Page Links, Link Information, 
and Page Information windows.    This information is not automatically stored to disk.    If you need it for 
later use, you should use the File|Save HTML File As... option.    When the file is reloaded, all information
will be re-displayed.

When verifying a set of pages, InfoLink builds a Result File for each page verified and lists the result 
pages in the appropiate Errors and No Errors tabs in the format of filename## along with the specified 
extension.    These files are automatically saved to disk in the application's Results directory.

To open page results, select the Result File you want to view from the Errors or No Errors tabs and click 
the View|Results menu option.    This will open the Result File and display all information in the 
verification windows.    Also, when Result Files are displayed, two buttons will appear at the bottom of the
listbox.    These buttons allow scrolling through each Result File.    The buttons have no effect unless the 
Errors or No Errors tab is focused.

When the Result Files are listed, you may wish to view them in an external browser.    To do so, click the 
Open in Browser button on the Main screen.    The page that is opened is frame-enhanced so the 
browser must support frames.    The frame Result File is saved in the application directory as \Results\
resultframe.htm.    To open the results from an external browser, you will need to specify this filename. 

When verifying a site or Page List, another set of reports are built in addition to the verification result 
files.    The Site Reports and Page List Reports have more information to assist you in maintaining your 
site and can be viewed in the InfoLink Report Viewer or an external browser.



General Preferences
The General Preferences allow you to change features of the program such as display, results, startup, 
and external file locations.

Result Preferences

Report Options 
Include Successful Links in Results - If this option is checked, the HTML results that are 
displayed from the main window of InfoLink will list all links, whether successful or failed.

Include Successful Links in Site and Page List Reports - If this option is checked, the reports 
built that and displayed in the InfoLink Report Viewer will include all links, both successful and 
failed.

Disk Cache
Clear Disk Cache - When clicked, this button will clear the contents of the Result List window and 
delete any associated InfoLink Edit File from cache.    All files that are cached contain information 
about the pages that have been verified.    This information is maintained for the use of the InfoLink 
Editor to help it identify and correct any broken links found.    If these files are cleared, InfoLink will 
not be able to assist in editing the broken links found.    The files cached are very small:    unless the
page verified has a large number of broken links, the files are usually less than 1KB in size.    
Clearing cache is the same as if you opened the Results List window and cleared each entry listed.

Display/Startup

Screen Display
Show Tool Bar - Toggles the toolbar on the InfoLink Main window.

Show Status Bar - Toggles the status bar on the InfoLink Main window.

Browser Display
View Browser in Full Screen - This option will make the browser expand to the width of the Main 
window.    This is useful if you are browsing through Result Files after verifying a set of pages.

Load on Startup
BiggByte Site - If this option is checked, InfoLink will automatically load BiggByte's home page 
when the program starts.    This option has no effect when command line parameters are passed.

Home Page - If this option is checked, InfoLink will load the URL specified in the space provided 
when the program starts.    This option has no effect when command line parameters are passed.

Browser Options
Use the buttons to the left of the mini-browser to change the options of the InfoLink Browser.    The 
mini-browser will display the changes as you make them.    The information appears as it will look 
on the Main window.    The options set from within the browser will apply only if the page currently 
being loaded does not specify such information within itself.

External Files
Enter in the space provided a default browser and/or editor to use when opening files externally.





Verification Preferences
Setting verification options in InfoLink Link Checker determines how InfoLink will manipulate the links 
that it encounters.

Verification

Verify These Links
All Links - Setting this option will inform InfoLink to return all hyperlinks and test them against other
specified settings.
Local Links Only - Selecting this option will inform InfoLink to only return relative links listed in the
HTML page.
Remote Links Only - Selecting this option will inform InfoLink to only return absolute links listed in
the HTML page.

Verify These Link Types
Check the link types you wish InfoLink to verify.

Netiquette
Use the slider bar to specify a desired time.    Time can be between 0 to 5 seconds.
After each link is verified - Choosing this option will cause InfoLink to delay the specifed amount 
of time after verification of each link.
After each page is verified - Choosing this option will tell InfoLink to delay the specifed amount of 
time after verification of page has complete being verifyed.
After both - Choosing this option will cause InfoLink to delay the specifed amount of time after 
verification of each link and after each completed page.

Request Options
User Agent - Use the drop down list to select a User Agent that you would like for InfoLink to send 
with its verification request.

General

Default News Server
In order for InfoLink to verify News Groups, a valid news server must be entered in the News 
Server edit box.    The server must be entered in the following format:    "news.server.net".

Frames
Never Check For Frames - Set this option to ignore searching for frames.
Notify When Frames are Present - Choosing this option causes InfoLink to create a Frame 
Information Page listing all frames found.
Show All Frames Found - If this option is checked, InfoLink will display each frame page found 
and list each with its own set of links.    This will allow you to view each frame and select only the 
links within each frame you wish to verify.    (See HTML Frames for more information.)

Time Out
Time out represents the amount of time InfoLink will wait for a response from a server.    Time outs 
are represented in seconds.    Values between 30 and 180 seconds can be entered.    If a non-
numeric value is entered, the time out will default to 60 seconds.    If the value entered is outside of 
the valid range, the default will be either 30 seconds or 180 seconds (whichever is nearest the 
entered value).



Authenticated Pages
Enter a username and password on pages or sites that require authentication.

FTP Logon
FTP requires a user name and password for verification.    The default for user name is 
"anonymous".    The password defaults to "guest".    This is acceptable for many FTP servers;    
however, your full e-mail address is usually requested.    This allows for system administrators to 
keep track of who is visiting their site.

Using the Skip Feature

InfoLink allows certain domains or character combinations to be skipped during verification.    This is 
most useful when verifying such links as external counters that tend to take long periods of time to verify. 
Simply add and remove items from the list as needed.    When adding an item to the list, you can specify 
whether it should be ignored only when downloading pages, when verifying links, or anytime it is 
encountered.    Each item in the list will have an associated checkbox.    Unchecking the item is the same
as deleting it.    To maintain a single list, uncheck any item that should not be included.    Then when the 
item should be included again, simply turn the checkbox on again.    

Note:    This list is intended for domain names (www.slowpage.com).    However, any values entered in 
this list will be compared (Case Sensitive) to the link being retrieved or verified, and if any one of the 
items in the list is a substring of the current link, the link will be ignored.    For example:    If you are 
verifying the link "http://www.biggbyte.com/myfiles/order.html" and "order" is an item in the list, this 
link will NOT be retrieved.    Also, use this list to exclude complete directories of your site from being 
downloaded and/or verified.    In the example above, adding "/myfiles/" to the list would exclude any 
pages and/or links from that directory from being retrieved and/or verified.

Attention ISP's:    When verifying a page that contains links to your users' pages, you can include in this
list anything that identifies them as user pages.    For example:    Many ISP's put a tilde (~) in front of 
their users' pages.    In this case, entering the "/~" in the skip list will inform InfoLink that pages 
containing these character are not to be retrieved and verified.



Network Preferences
The Network Preferences window provides space for you to enter a proxy server to use when 
connecting to locations on the Internet.    Just enter the address in the space provided.

If the Use Proxy option is checked, InfoLink Link Checker will use the address and port specified. 
Otherwise, no proxy will be used.    The address should be entered in the format of 
"www.yourproxy.com" without the "http://".

Both the Proxy Address and Port fields must contain valid information before the proxy will be used.

Entering a domain and port in the No Proxy For section will inform InfoLink to bypass the proxy when 
encountered.    To add a host and port to the list, use the Add button.    When prompted, enter the host 
and port information in the format of host:port.    If no specific port is needed, enter only the host.    
When no port is specified, InfoLink will add "***" to the port listbox and associate it with the appropriate 
host.

To remove a host:port from the list, select the desired host and click the Remove button.



InfoLink Lookup
InfoLink Link Checker provides Lookup features which allow a user to find out information about Host 
Names, Internet Addresses, Services, and Ports.

Address By Host
Finds Internet Address of a Host Name (www.biggbyte.com --> 208.201.34.151).

Host By Address
Finds Host Name of an Internet Address (208.201.34.151 --> www.biggbyte.com).

Port By Service
Finds Port by specified Service (whois --> 43).

Service By Port
Finds Service of specified Port (43 --> whois).



Command Line Parameters
If you use a scheduling program, you can use the parameters below to verify your pages automatically.    
When InfoLink verifies a Page List or verifies a Site with command line parameters, the program will 
automatically shut down when verification has completed.    Any other parameters passed will NOT shut 
down InfoLink after processing.    

When verifying a site with paramaters, InfoLink will automatically save the site's pages to a Page List 
called "CmdPageList.htm" and save this file in the "Files\SiteList" directory.    Verification Results will 
be saved as "CmdSite##.htm" in the Results directory and the main report name of the Site Reports 
will be saved as "CmdSite.htm" in the Reports directory.    See the Site List Manager for more 
information on report names.

When verifying a Page List with parameters, the Verification Results will be saved as 
"PageListFileName##.htm" and stored in the Results directory and Page List Reports will be saved 
and stored in the Reports directory as the the Page List file name plus the letters "pl".    For example, if 
you use the command line parameters "a p D:\Infolink\Files\SiteList\MySitesPages.htm" to verify the 
Page List, the Verification Results will be saved as "MySitesPages##.htm" and the main Page List 
Report will be saved as "MySitesPagespl.htm".    (See the Page List Manager for more information on 
Page List report names.)

Before scheduling a Page List with InfoLink, check to ensure that the paramters are correct by passing 
them and loading InfoLink normally.    If the parameters are incorrect when passed, InfoLink will not 
automatically shut down.    If, when scheduling a Site to be checked, InfoLink encounters an error on the 
initial page, Site Reports will record the error, and InfoLink will close normally.

Loading a file on start-up

InfoLink Link Checker will open a file from disk or from the Internet upon start-up if you have entered the 
desired location as a single parameter.    If the location parameter is an http address, it must be the full 
URL (http://www.biggbyte.com).    If the location parameter is a file from disk, the file must exist and the 
full path must be specified.    If the location parameter is invalid, InfoLink will ignore the parameter and 
open the program normally.

Example:      c:\infolink\infolink.exe http://www.biggbyte.com

Verifying links on start-up

When verifying links with command-line parameters, the following arguments must be entered and 
they must be in this order:

"What Links" Parameter:
· a - Specifies that all links be checked. 
· l - Specifies that only local links be checked.
· r - Specifies that only remote links be checked.

This is the option in the Verification Preferences window that tells InfoLink whether to retrieve all pages, 
local pages only, or remote pages only.    If this option is invalid, then All links will be assumed.

"What Type of Verification" Parameter:
· p - Specifies that a Page List    will be verified.
· f    - Specfies that a file from disk will be opened and verified.
· w - Specifies that an Internet address will be opened and verified.



· s - Specifies that a site check will be performed.

The Page List can be any valid file from disk.    It is recommended that you let InfoLink maintain any 
Page List.    If you use command line parameters to verify a Page List, you should add it to the Page List 
Manager first and then point the command line to that file.    If the file does not exist or if an Internet 
address is specified, InfoLink Link Checker will ignore the parameters.    When a Page List is opened, 
verification will start instantly after all links are retrieved.

If verifying a file from disk with the command-line parameters, the file must contain the <Base Href> tag 
or the InfoLink Comment.    (For more information, see Verifying Files from Disk.)

When a web page is to be opened and verified with command-line parameters, if the specified address 
is accepted by InfoLink, the page will successfully be opened.    If the address is not valid or an error 
occurs while trying to connect, no page will be opened, and InfoLink will load normally.

Specifying a page with the site parameter will perform the same task as opening the Site List Manager 
and verifying a site from there.    This address must be a valid http address.    If the address is not valid, 
no page will be opened.

Location to open:

This parameter specifies the location of the file to open.    This file can be any valid http address or a file 
from disk.    Any invalid location will result in an error.

Examples:

Below are examples of parameters that can be passed to InfoLink Link Checker.    These parameters do 
not require any preceding characters such as the minus sign ("-") or forward slash ('/").    Only the 
characters listed above should be passed.

Opening a location:

· http://www.biggbyte.com - Will open the location, display the file, and retrieve links according 
to options set in the Verification Preferences window.

· c:\infolink\biggbyte.htm - Will load and display the file, then retrieve links according to the 
options in the Verification Preferences window.

What Links:

· a s http://www.biggbyte.com - Will inform InfoLink to connect to the location 
http://www.biggbyte.com, retrieve all pages, and verify all links in each page found.

· l f c:\infolink\htmlfile.html - Will inform InfoLink to open the file c:\infolink\htmlfile.html from 
disk and verify only the local links (Partial) found in the page.

· r w http://www.biggbyte.com - Will inform InfoLink to connect to the address 
http://www.biggbyte.com and verify only the fully qualified links (Remote) found in the page.

What Type of Verification:

· a p c:\infolink\files\sitelist\sitespages.htm - Will inform InfoLink to open the file c:\infolink\
files\sitelist\sitepages.htm as a Page List, retrieve each fully qualified link, and verify all links 



from each page.

· a f c:\infolink\htmlfile.html - Will inform InfoLink to open the file c:\infolink\htmlfile.html and 
verify all links found in the page.

· a w http://www.biggbyte.com - Will inform InfoLink to connect to the address 
http://www.biggbyte.com and verify all links found.

· r s http://www.biggbyte.com - Will inform InfoLink to connect to the address 
http://www.biggbyte.com, retrieve all pages in the site, and verify only the fully qualified links 
(Remote) found in the page.



URL Information
As InfoLink Link Checker visits different pages and verifies different links, a link information and pages 
visited list is maintained and displayed in the URL Information Window.    All Pages and Links are listed in
the associated tabs.

Page Information
Each page entry contains information about that page.    Each entry contains the address, file size, and 
the number of links in the document.    The number of links displayed will vary depending on how the 
preferences are set in the Verification Preferences window.

The list of pages will continue to grow until there are 2500 entries in the list.    When this limit is reached, 
the first 1000 entries will be deleted and the list will then continue to grow from 1500.

Link Information
Each link that is verified is stored with various information about the status of that link.    Verification 
information, along with the parent link, is held in this list.    The status of the links can be determined by 
the image that displays with it.

The list of links will continue grow until there are 3500 entries in the list.    When this limit is reached, the 
first 1000 entries will be deleted and the list will then continue to grow from 2500.

At any time when the program is running, this list can be examined.    If needed, each list has an 
associated pop-up menu that can be used to clear the contents of each list.



Page Links
The Page Links list displays all the links found in the page.    Each item in the list has sub-items that 
show the status, description, error, moved location (if applicable), verification time, and link type.

The type of each link determines its associated image.    When a link fails, it will appear with a broken 
link image.    All link types (http, https, ftp, news, mailto, gopher) have different images.

When an item from the list is selected, you can use the Link Information button to view more statistics 
about that particular link.

At the bottom of each result file returned after verification, you will find an HTML comment (<!- ->).    The 
comments are used by InfoLink to determine if the file being opened is an InfoLink result file.    If this 
information is edited, it may keep InfoLink from displaying results correctly.    All the verification 
information you see on the Page Links, Link Information, and Page Information lists can also be found 
stored within this comment tag in comma-delimited form.    This information can easily be manipulated for
use other than viewing InfoLink results.    If you need a comma-delimited file for database purposes, you 
may be able to extract this information from the result files.    For convenience, just above the comma-
delimited information you will find a description of each item listed.



Link Information
The Link Information button opens a list of statistics about the currently selected link in the Page Links 
list.    Each link has its own set of statistics.    To view a set of statistics, select a verified link from the 
Page Links list.    The information about that link is automatically listed in the Link Information window.    
When the Link Information window is visible, you can continue to the next link by double clicking at the 
bottom of the list.

At the bottom of each result file returned after verification, you will find an HTML comment (<!- ->).    The 
comments are used by InfoLink to determine if the file being opened is an InfoLink result file.    If it is, all 
the verification information will be added to the verification windows.    If the information in this 
comment is edited and opened later, it may keep InfoLink from displaying results correctly.    All 
the verification information you see on the Page Links, Link Information, and Page Information lists can
also be found stored within this comment tag in comma-delimited form.    This information can easily be 
manipulated for use other than viewing InfoLink results.    If you need a comma-delimited file for 
database purposes, you may be able to extract this information from the result files.    For convenience, 
just above the comma-delimited information is a description of each item listed.



Page Information
The Page Information feature displays information about a particular page.    Some information 
displayed includes http version, server, page size, number of links, and the number of valid and invalid 
links.

At the bottom of each result file returned after verification you will find an HTML comment (<!- ->).    The 
comments are used by InfoLink to determine if the file being opened is an InfoLink result file.    If the 
information in this comment is edited, it may keep InfoLink from displaying results correctly.    All 
the verification information you see on the Page Links, Link Information, and Page Information lists can 
also be found stored within this comment tag in comma-delimited form.    This information can easily be 
manipulated for use other than viewing InfoLink results.    If you need a comma-delimited file for 
database purposes, you may be able to extract this information from the result files.    For convenience, 
just above the comma delimted information is a description of each item listed.



Verification Results and Reports
InfoLink builds three different sets of reports.    The standard result files are displayed and viewed in the 
InfoLink Browser after any verification has completed.    Two additional sets of reports are built according 
to whether a site or a Page List has been verified.    All these reports can be viewed in InfoLink or an 
external browser.    All reports are frame-enhanced, so the browser used must support frames.    The 
reports are generated and stored in the application's Reports directory and may not work if moved to 
another directory on your hard drive.

When any result file or report is generated, InfoLink includes all links found unless otherwise specified in 
the General Preferences window.    Depending on the number of links verified, the reports generated by 
InfoLink may be extremely large.    It is recommended that for large sites you Turn Successful Links Off
when verifying.    If successful links are off, various reports will display the line Successful Links 
Removed by User Option. 

In result files and reports, if successful links are to be reported, all invalid links will be posted before the 
valid links.

Verification Results
Previous versions of InfoLink displayed results in the InfoLink Browser with a simple Verification Results 
file.    These Verification Results are still available, only with a new format to display them.    Along with 
these HTML results, you can use the Page Links, Link Information, and Page Information to get 
additional verification information.    Once a set of pages have been verified by either a site check or 
Page List, you can open these results in an external browser by clicking the Open in Browser button on 
the Main screen.

Site Reports
After verification has been completed for a site, InfoLink builds a set of detailed reports about the site.    
These reports are displayed in the InfoLink Report Viewer, but they can also be viewed in an external 
browser.    There are a total of eighteen Site Reports built, along with four index reports.    The information
in the reports allows you to see statistics about your site, find where problems occurred and where they 
are located in the verified page, information about the internal and external links, changes in your links, 
and download times.    The information is presented in a manner that is easy to read and navigate.    The 
reports sort the information by different data.    For example:    The Verification Detail report will be 
sorted by the actual page that was verified with all problems links in sorted order and the Link 
Information report will be sorted by the URL that was verified.

Page List Reports
When verification of a Page List has been completed, a set of reports is built containing detailed 
information about each page found in the Page List.    These reports are displayed in the InfoLink Report 
Viewer, but they may also be opened in an external browser.    There are a total of twelve Page List 
Reports built, along with four index reports.    The Page List Reports provide much of the same 
information as the Site Reports.    Some reports NOT created when checking a Page List are:    Image 
View and Link Changes Reports.    These reports apply only when verifying a set of pages from the 
Page List Manager (for example, verifying only a certain number of pages from a single Page List, a set 
of Page Lists within a Page Group, or a complete Page Group).    For a description of each, see Page 
List Manager Description.

Report Descriptions
Below is a description of each report generated by InfoLink when verifying a Page List or a site.    Each 
report contains information to assist you in various ways in maintaining, examining, and reporting the 
validity and status of your site.

· About My Site - (Site Only) Lists various information about your site.



· Verification Detail - (Site and Page List) Displays a detailed list of the links verified.
· About My Images - (Site and Page List) Image Report Index.
· Image View - (Site Only) Displays each image found on your site.
· Image Information - (Site and Page List) Displays properties of each image in your site or 

Page List.
· Image References - (Site and Page List) Displays HTML image references and parent links.
· Image Totals - (Site Only) Shows statistics about the images found in your site.
· About My Links - (Site and Page List) Link Report Index.
· Link Information - (Site and Page List) Displays properties of each link in your site or Page 

List.
· Link References - (Site and Page List) Displays HTML link references and parent links.
· Link Addresses - (Site Only) Lists all the addresses your site links to.
· Link Servers - (Site Only) Lists all the servers your site links to.
· About My Pages - (Site and Page List) Page Report Index.
· Page Information - (Site and Page List) Lists statistics about each page verified.
· Page Errors - (Site and Page List) Lists any pages that could not be verified and why.
· Page Downloads - (Site and Page List) Download Report Index
· Fast Downloads - (Site and Page List) Lists all pages rated as fast downloads.
· Slow Downloads - (Site and Page List) Lists all pages rated as slow downloads.
· All Downloads - (Site and Page List) Lists all downloads and their ratings.
· Broken URLs - (Site and Page List) Lists any pages or links that had problems.
· Link Changes - (Site Only) Lists any changes in your site's links since the last verification.
· Page List Summary - (Page List Only) Summary of all pages verified in your Page List.
· Site Summary - (Site Only) Summary of all pages verified in your site.



Document Information
The Document Information window displays information returned from the server about the current 
page.    Information returned will vary from server to server.

Use this window to get quick information about the current page.    Some information displayed may 
include Date, Server, Last-Modified, Content-Length, and Content-Type headers.

When browsing with the InfoLink Browser, you may come across a page that has moved or been 
redirected.    If an active link is not returned within the HTML page returned from the browser, you can 
use the Document Information window to get the address of the new location.    Also, double-clicking 
on the Location: entry returned by the server will automatically browse to that location.



InfoLink Report Viewer
The InfoLink Report Viewer displays an extensive set of reports created after verifying a site or Page 
List.    These reports are displayed in an explorer-style interface for easy access.

When the Report Viewer is first opened to display reports, it will display a tree representing the site or 
Page List verified.    The contents section of the viewer will display descriptions of each report along with 
a build status of each report.    When the status of a report changes, its progress will be displayed.    
When all reports have been completed, all toolbar options will enable, allowing you to view the reports.    
Note:    Depending on the size of the site or Page List being verified, the process of building reports may 
take long periods of time,    and the reports may become very large.    

To view a report, you will need to be in Reports Mode.    If the contents section of the viewer is 
displaying descriptions of each report, you are in Descriptions Mode.    To change to Reports Mode, 
use the toolbar or the Report menu and select the Show HTML Report option.    Then, selecting a report
from the tree will display that report in the Report Browser.    

When the viewer starts to open the selected report, it checks the size of the file.    If it is greater than 
250KB, you will be given the    opportunity to open the reports in an external browser if you so desire.    
When the report set is large, it is recommended that they be opened in an external browser for faster 
display.

When the reports have been built, you may open them in another browser by choosing the option Open 
in External Browser option from the File menu.    The reports are frame-enhanced, so the browser used 
must support HTML frames.    When the reports are opened externally, they will display similiar to the 
look of the Report Viewer.

To print a single report, select the desired report from the tree.    When the report has finished displaying 
in the Report Browser, select the Print option from the File menu.    (See also Printing Browser Contents.)

To open an existing report, use the Open Report option in the File menu.    A dialog will appear prompting
for a report file name.    Select the main report name from the dialog, and the report will open ready for 
viewing.    

Note:    The report name is determined by the name of the result file specified in the site list if Site 
Reports are built.    If the reports built are for a Page List, the report name will be the name of the Page 
List that was verified or the name of the Page List Group if the whole group was verified.    To keep Page 
List and site reports from being overwritten, all Page List reports will have the letters "pl" added to the 
end of the file name.    (For more information, see Site List Manager and Page List Manager.)



Results List
The Results List contains all pages with errors that have been verified.    Each item in this list is 
associated with a file in the application's cache directory.    Each entry will contain the address of the 
page, page title, the number of broken links, and the time and date it was checked.

When InfoLink Link Checker checks links in a page and encounters a broken link, the link is stored along
its relevant information.    When the page has been completely verified, if there were errors, the page is 
stored in the Results List and is associated with a cached InfoLink Edit File (".ief").    InfoLink Edit Files 
are very small, rarely larger than 1KB in size.

There are many ways to open an InfoLink Edit File.    Simply drag the selected page and drop it on the 
InfoLink Editor, double-click the desired page, or select a page and click the Edit button.    When a page 
is about to be opened for editing, a dialog will appear prompting for a location of the file.    Once the 
location has been entered, InfoLink will either open the file from local disk or from the Internet, 
depending on what was entered.    If the file entered is located on disk, InfoLink will display the HTML file 
in the editor along with the associated errors.    If the location entered was an Internet address, InfoLink 
will attempt to open the file from the Web.    Once the page is downloaded, it will be displayed in the 
editor along with any broken links found.

This list will continue to grow until the user has removed an item or all items.    To remove an item, select 
a page and click the Remove button.    To remove all items in the list, click the right mouse button and 
select the Clear All option.    This list can also be cleared from the General Preferences window.

Note:    When an item is removed from the Results List, its file stored in cache is removed as well.



History List
Each time a page is successfully received, its address is stored in the History List.    To return to any of 
these locations, go to the History List window located in the View menu.    All of the addresses are listed
in the list box in the order in which they were received.    To jump to one of the locations listed, either 
double-click on the desired location or highlight it and click the OK Button.

The History List will continue to grow until 250 pages have been visited.    When this list reaches the 
maximum number, it will start over and begin replacing addresses starting at the first item in the list.

This list is also cleared when the progam shuts down.



Quick Verification
At times you may only need to verify one or two links.    This can be accomplished by using the Quick 
Verification feature.    Under the Internet menu, the menu item Quick Verification contains a sub-menu 
which has the following five items:

· Web Page
· E-Mail Address
· Newsgroup
· FTP
· Gopher Site

Select the type of link to verify, and a dialog prompt will appear.    Enter the address to verify, and click 
the OK Button.    The address entered will be verified and returned in the InfoLink standard result file.



Verify a Single Page
To verify a single page with InfoLink Link Checker, enter the address in the URL location on the Main 
screen.    Click the Location button, and InfoLink will open and display the page.    All links will be 
displayed in the Links list box.    Select the links you wish to verify and click the Check Links button.    To 
verify all the links found, unselect all links in the list.

See Verifying Disk Files for more information on verification of local files.

After verification has been completed, a result page will display in the browser with the status of each 
link verified.    All information about each link can be viewed using the HTML, Page Links, Link 
Information, and Page Information buttons at the bottom of the InfoLink Browser.    This is the only 
report returned when a single page is verified.    To get a set of reports, use the Page List Manager or
the Site List Manager.



Verify Sites with InfoLink
To verify a complete site with InfoLink, you must add the site to the Site List Manager.    Once InfoLink 
has the information stored, you can use the Open List button to quickly select the site you wish to verify.  
The options entered for the site will be used when verification starts.

After verification has completed, InfoLink will build a set of reports about your site.    To view the reports, 
use the InfoLink Report Viewer.

To quickly verify a site, use the Open List button on the Main screen.    When you click the Open List 
button, a pop-up menu appears with an option "Verify Site...".    Selecting an item from the menu list will 
automatically start verification of that site.    The current options of that site in the Site List Manager will 
be used.

If the site has specific options (i.e. passwords), you must change these with the Verification Preferences 
before starting verification.

For more information, see the example Using the Site List Manager.



Pause Verification
InfoLink Link Checker can be paused during verification by simply clicking the Pause Button.    A window 
will appear that continually updates and displays the amount of time that has passed since verification 
was paused.



What Links are Verified
InfoLink Link Checker Verifies

· http, https
· ftp
· news
· mailto
· gopher (Site Only)

Verifying HTTP Links:

InfoLink Link Checker will find any http link in an HTML document.    Links with special ports will be found
and used (http://www.biggbyte.com:8080).    It has become common to put links inside the <FORM> .. 
</FORM> tags.    Some pages have their links listed in combo boxes or in the submit buttons.    InfoLink 
WILL look for links in these tags as well as the standard <HREF> tags.    Links that contain a jump to 
location within a document are stripped down to the links without the "#jumpname" references.

Verifying FTP Links:

The way that InfoLink verifies ftp links depends on how the ftp link is referenced.    If the link points to a 
ftp site only (ftp://www.ftplink.com), then InfoLink simply tries to connect to the site.    For links 
referenced with the URL as a directory (ftp://www.ftplink.com/bin/programs/), InfoLink will make the 
connection, log in using the login name and password specified in the Verification Preferences window, 
and attempt to change to the directory specified.    Lastly, for links which specify a file name 
(ftp://www.ftplink.com/bin/programs/ftpprog.exe), InfoLink will do the same as above, then request a 
directory listing and search that list for the specified file.

Verifying News Links:

News groups are verified by connecting to the News Server entered in the Verification Preferences 
window and searching for the specified news group (news:alt.winsock.programming).    InfoLink will 
only verify News links as shown here.    Links that point to a news server are not verified.

Verifying Mailto Links:

Mailto links are verified as long as the server will support the Finger protocol.    Many servers disable this
protocol, in which cases InfoLink will be unable to complete the verification.    Mailto links that are 
concatenated by a comma (Mailto:me@somewhere.com,me@here.com,me@there.com) will all be 
verified.    Since most of the links in HTML pages are not Mailto: links, InfoLink defaults the option to 
verify mailto links to false.

Verifying Gopher Links:

Gopher links are verified only by attempting to connect to the actual gopher site.    Any files that are 
referenced will not be verified.
For Example:    gopher://gophersever.com/00/dir/ would be considered a successful link as long as 
InfoLink could connect to "gopherserver.com".



Verifying Image Links:

Any image referenced in an HTML document can be verified.    If an image represents a client-side 
imagemap, the image and the links contained between the <MAP>..</MAP> tags will be verified.    
Server-side imagemaps are not verified.

Verifying Frame Links:

When a page with frames is opened, each frame page is listed and displayed.    If a frame page can not 
be retrieved, the error will be displayed in that page's Browser tab.    (For more information on frames, 
see HTML Frames.)

Redirected Links:

When normally verifying a link that has been moved, a redirected or moved error will be returned.    
However, if a link is listed as a redirected link, InfoLink will retrieve only the information that points to the 
redirected location.
For Example: Yahoo has many links that redirect to another location.    When InfoLink encounters a link 
like "http://www.yahoo/homem/?http://www.yahoo.com/search/people/", InfoLink will only retrieve 
the "http://www.yahoo.com/search/people".

You can specify which types of links that InfoLink should check in the Verification Preferences window.



HTML Frames
HTML frames are fully supported by InfoLink Link Checker.    When a page with frames is encountered, 
each frame page, including the <NOFRAMES> page, will be retrieved and displayed along with a Frame
Information Page.

Each page found will contain its own collection of data.    The full URL of each page is the caption of 
each tab.    As the Browser tabs are changed, that page will be displayed in the browser and that page's 
links will be listed in the Links Tab list box.

When frames are found, each frame is listed in the Frames Tab list box.    Each frame plus the frame 
page itself is listed in the Pages Tab list box.

To view the links of a frame page, click on the tab of the page you wish to view.    That page's links will be
displayed in the Links Tab list box.

There are a number of ways to check links in a page containing frames.
· Select the frame page from the list displayed on the Frame Information Page and click the 

"Verify Frame" button.    InfoLink will then check the links of that page and return the results in 
the browser window associated with that frame.

· Click the tab of the frame page you would like to verify.    That page's links will then be listed in 
the Links Tab list box.    Click the Check Links Button to check those links.    The results will be 
listed on the same tab that was chosen for verification.    To check another page, simply go to 
another tab and do the same.

· To check all the frames found, use the button "Verify all links in each page" at the bottom of 
the Frame Information Page.    

· You can add the frames to the Page List or create a new Site List entry and start your verification
from one of those windows.

If each page's links are verified separately, you should save the results as soon as verification has 
completed.    It is recommended that you choose to verify all links in each page by clicking the button at 
the bottom of the Frame Information Page, adding them to the Page List, or creating a new Site List 
entry.    By doing one of these, verification of the pages will ensure their results are saved to disk.    
Choosing the button at the bottom of the Frame Information Page will save results to disk as 
frameresult##.htm.

Options for checking for frames can be changed in the Verification Preferences.



Determining Links with a Base Link
Determining Base Links For the Internet:
InfoLink Link Checker first checks to see if there is a <BASE HREF> tag in the HTML file. If one exists, 
InfoLink uses it.    If one does not exist, the location that was read is used.

For example: 
Visiting the page "http://www.myname.com/mydir1/mydir2/myfile.htm"
This would produce a Base Link of http://www.myname.com/mydir1/mydir2/.

A link in this page like <A HREF="myfile.htm"> 
would become "http://www.myname.com/mydir1/mydir2/myfile.htm".

A link in this page like <A HREF="/myfile.htm"> 
would become "http://www.myname.com/myfile.htm".

A link in this page like <A HREF="../myfile.htm"> 
would become "http://www.myname.com/mydir1/myfile.htm".

A link in this page like <A HREF="../../../myfile.htm"> 
would become "http://www.myname.com/myfile.htm".

Visiting the page "http://www.myname.com/myfile.htm"
This would produce a Base Link of "http://www.myname.com/".

Determining Base Links For Files on Disk:
InfoLink verifies HTML files on local disk by treating them as though you were browsing to them on the 
Internet.    In order to do this, InfoLink must have a location from which to interpret the relative links in the
file.    This is done by either the <BASE HREF> tag or an InfoLink Comment.    When InfoLink prompts 
you to enter a Base Link, you need to simply enter the URL for the file as it is on the Internet.

For Example:
Consider a file on disk called "thisfile.html".    When you open this file in InfoLink, if there is no <BASE 
HREF> tag or InfoLink Comment, you will be prompted to enter a Base Link in the Base Link window.    
What you should enter is the same address as you    would in your favorite browser to open the page on 
the Internet.    Thus, if the file is located at "http://www.yourserver.com/files/thisfile.html", then this is 
what you should enter.    After this address is entered, InfoLink will be able to treat the file as though you 
were browsing to it on the Net.    InfoLink will insert this address at the top of your HTML code in a 
comment (<!- ->) tag, so it will not affect your file.    If your HTML file has a <BASE HREF> tag, you will 
NOT be prompted for a Base Link, and the same rules as above will apply.

If nothing is entered when prompted for a Base Link, InfoLink will still open the file and retrieve the links.  
However, some links may be interpreted incorrectly, and you could get erroneous results.

If the Base Link entered in the the InfoLink Comment is incorrect, you will need to open the HTML file in 
an editor and delete the comments InfoLink added at the top of the page or simply correct the addess 
shown.    The comment with the Base URL MUST be in the same format or InfoLink may not be able to 
understand it.    It is recommended that you delete the comments and re-open the file in InfoLink.

When adding a file to the Page List Manager, an InfoLink Comment or a <BASE HREF> tag MUST be 
present, or InfoLink will view it as an error when trying to verify the page.

Understand that the Base Link that InfoLink will ask for is nothing more than a HTML <BASE HREF> 
tag.





Base Link Window
The Base Link window provides you with a way to tell InfoLink where the file you are opening from disk 
is located on the Internet.    By getting this location, InfoLink can interpret links correctly and also allow 
you to do some browsing with the InfoLink Browser.

When you see the Base Link window, you should enter the Internet address of the file that you are 
opening.    If the file you are opening has a <BASE HREF> tag, the Base Link window will not appear; 
InfoLink will simply use the <BASE HREF> information found in the file to determine the Internet 
address.

When you have entered the correct address, click the Close button to return.    If nothing is entered, 
InfoLink will continue without a Base Link.    This may result in incorrect results.

When adding pages to the Page List Manager, you may be prompted to enter a Base Link.    If so, in 
order for the file to added to the Page List Manager, you MUST enter a Base Link.

(For more information see Determining Base Links.)



Printing Browser Contents
After a file is displayed in the InfoLink Browser, it can be printed by clicking the Print option under the 
File menu.    To set up your printer, go to the Printer Setup option.

When a file that contains the <FORM> tag is printed, anything coded inside the <FORM> tag (command 
buttons, edit boxes, radio buttons, etc.) will print on the hard copy as a small square.

When a set of reports is opened in the InfoLink Report Viewer, you can print any file displayed by using 
the File|Print option. 



Tips for Using InfoLink Link Checker
InfoLink Link Checker is a very useful tool for assisting you in the maintenance of your web 
pages.    In this help topic, you will find information to help you to make the most efficient and 
effective use of InfoLink Link Checker.

First Tip:    Help InfoLink continue to improve by offering suggestions and comments.    
Second Tip:    Help InfoLink be known by putting a link from your page to ours with one of the 
icons located on our home page (http://www.biggbyte.com).

                                                                                    
Tips for verification performance enhancement with InfoLink Link Checker:

· Heavy traffic on the Internet will decrease the speed of verification.    Try to verify your pages 
when bandwidth is lowest.

· Before you edit any links that may be broken, look at the HTML link and syntax.    Make sure the 
error wasn't due to a misspelled word.    For moved links, check to see if you included the ending
back slash ("/").    Most moved link errors are caused by this.    Most browsers will handle this for 
you by automatically sending you to the correct location; however, this does return an error from 
the server and causes browsers to send two requests, taking more time to retrieve the page.

· If you are verifying only the local links in your document, set the time-out to a lower value.    More
than likely the requests don't have to travel very far to get the information, so it is not likely that 
the verification will Time-Out.    When you are verifying remote or all links, set the time-out to a 
higher value.

· If your e-mail address is the only mailto: link on your page, specify in the Verification Preferences
window that InfoLink not look for e-mail links.    For this reason, the e-mail option will default to 
false.    If your document does not contain any ftp, gopher, or news links, unselect those options 
as well.    This will reduce unnecessary parsing and improve overall performance.    If your site 
doesn't contain HTML Frames, you should choose the option "Never Check For Frames" as 
well.

· If performing a Site Check, specify that InfoLink save all the Page Links to a file on disk.    Then 
when you need to verfiy your site again, specify in the Site List Manager that InfoLink use the 
pages in that file for your site.    InfoLink will then open that file and retrieve its links.    This will 
eliminate the time it takes to search your site and find all your pages.

· After all pages have been verified from the Page List or Site Check, all results are listed in the 
list box on the left side of the screen.    If the program is closed and re-opened, these results can 
still be viewed by clicking the Previous Page Results List option under the View menu.

· When you have viewed the results of a page and no longer need them, right-click the mouse and
click the Delete option.    This will remove the result page from the list of results.

· In the Site List Manager, keep all site names unique.    This will eliminate the chance of results 
and reports being overwritten. In doing so, you can also easily distinguish between different 
sites' result files and reports.    For Example:    If a site entered in the Site List Manager is the 
BiggByte Site, you would give the entry a title (BiggByte Software), enter the starting URL 
(http://www.biggbyte.com/), enter a result file name (biggbyte.htm), and enter a file to save the 
pages (biggbyte.htm).    The two files called biggbyte.htm will not be overwritten.    If you add 



another site the the list, you would want to call them something else.    For example, My Site, 
http://www.mysite.com/, myresult.htm, and myresult.htm.    This would keep all files' information 
unique.

· If you're an ISP and your site has pages that contain links to users' pages, enter in the skip list 
anything that may make your users' pages unique.    Many ISP's use the tilde (~) for this 
purpose.    By adding this character to the skip list, you can ensure that no links that contain this 
symbol will be retrieved.    Similarly, when doing a Site Check, you can specify that these links be
checked but not included as one of the pages in your site.    Therefore, when you start 
verification, only those pages that are directly related to your site will be verified.    This list can 
be valuable not only for an ISP but for users with any links that should be ignored.    A good 
example is if you have a directory on your server that does not need to be checked, you can 
enter that in the skip list.    In this case, when a link resembling that directory is found, it will not 
be retrieved.    The skip list is also useful for adding links such as external web-counters that 
tend to take long periods of time to connect.    You can add anything you desire to the Skip List.    
The Skip List can be found in the Verification Preferences window.

· If the pages you need to verify are on local disk, open the file from disk rather than opening it 
from the Internet.    This will eliminate the time taken up by downloading the page.    Each disk file
to be verified must contain the <BASE HREF> tag or the InfoLink Comment.    (See Verifying 
Files From Disk and Base Links for more information.)

· To verify a single link quickly, use the Quick Verification feature or open a file and right-click the 
mouse over the hyperlink, then click the Verify This Link option.

· If your page contains frames, make sure that in the Verification Preferences window the option 
Show All Frames Found is checked. When the file is opened, each frame will be displayed in 
its own browser window.    Select the page you wish to verify and click the Check Links button.    
The results of that frame page will be returned in that page's browser.    Though it is 
recommended to verify all pages at once, this is a quick way to check only one of the frame's 
links.    (See HTML Frames for more information.)

· After you have opened a result page from the Results List window, remove it from the list.    This 
will delete any cached files associated and release disk space.



Viewing Recent Results
Viewing the most recent Result Page
Each time a page is verified, the results are returned in HTML format.    This file can be viewed, saved to 
disk, or printed.    Any action that causes a new address to be retrieved will cause the entire window to 
be reset and all controls to be cleared.    (These actions may include entering a new location and clicking
the Location Button, browsing, or hitting the Clear Tool Bar Button.)    Therefore, any results displayed 
will be cleared.    To view the previous results, under the View menu, click the option Previous Results.    
This will cause InfoLink to re-display the last result page.

Note:    This result page is deleted each time a new file is verified.    If you wish to keep this result page 
longer, you should save it to disk.

Viewing the most recent Page Results List
When verifying links with the Page List or after a Site Check, each result file is saved separately.    After 
InfoLink has completed verification on all pages, the results and corresponding verified file are displayed 
a list box under the appropiate Errors or No Errors Tab.    (For information on viewing these results, see 
Viewing Page Results.)    When an action causes the screen to clear, these results will also be cleared.    
To view this result list again, click the Previous Page Results List under the View menu.

When the program is closed, this list can be re-opened when InfoLink is started again.

Note:    This list is maintained until another verification of a Page List takes place, at which time a new 
list is generated.

Viewing Previous Site and Page List Reports
To view a previous set of Verification Reports, open the InfoLink Report Viewer and use the Open Report
option in the File menu.    When the dialog appears, select the report name you wish to open.    Once 
selected, the Report Viewer will display the appropiate tree for you to view your reports.    (For more 
information on determining report names and examples, see Page List Manager and Site List Manager.)



Page List Manager Description
This is a demonstration of how to make the most efficient and effective use of the Page List Manager.

The descriptions below use only a single Page List File.    Everything in the examples would work the 
same with any number of Page List Files.

Description 1
I have one site to maintain (http://www.biggbyte.com/) and a rather large Bookmark file of links to 
various sites I like to visit.    What I should do to get the most out of the Page List Manager is to first 
create a new Page Group.    To do this, I use the Page List|New|Group menu option.    Once a new 
Page Group is created, I rename it to BiggByteSite by selecting the NewGroup(1) from the tree and re-
typing the name to read BiggByteSite.    Once I have my Group available, I need to create a new Page 
List.    In order to do this, I select the Group BiggByteSite from the tree then use the Page List|New|
Page List menu option.    A new Page List will then appear called NewPageList.htm.    I should rename 
that to BiggByte.htm in the same way I changed the Group name.    Now that I have the Page List 
created, I need to add links to it, so I select the Page List from the tree and use the Page List|Add Link 
to Page List option and continue this until all pages have been added.    

When I am finshed adding my links, I need to create a new Page List for my Bookmark file.    To keep it 
separate from my site, I should create another new Page Group.    I do this in the same manner as 
described above and rename the Group to Bookmark.    I then add my Bookmark file to the new group 
with the Page List|Add Page to Group option.    InfoLink will create a new HTML file called 
Bookmark.htm and store it in the application's Files\PageList directory.

Now that I have all my Page Lists set up, I can start verifying them.    I am going to verify two of the 
pages in my BiggByte Page Group first, so I open the Page List Manager and find the BiggByte group 
in the tree.    Then I find the BiggByte.htm Page List file under that group.    When I select it, all the 
URLs in the file appear in the contents window.    I only want to verify two of those pages, so I select the 
first two.    With the two URLs selected, I right-click on the contents window and select the Check 
Selected Pages option.    InfoLink then takes the two selected URLs, opens each, and verifies all their 
links.

Now I want to verify the complete BiggByte Page List.    I open the Page List Manager, and select the 
BiggByte.htm Page List from the BiggByte Page Group.    I then click the Page List|Verify this Page 
List menu option, and InfoLink opens the BiggByte.htm Page List file, retrieves all URLs from each 
page, and verifies the links in each.

Now I want to verify my Bookmark file.    I open the Page List Manager and find the Bookmark.htm 
Page List file in the Bookmark group.    I select the Bookmark.htm file in the tree.    Once selected, all 
the URLs in that Page List file are listed in the contents window.    I have two options here:    I can select 
only the URLs I want to verify in the contents window or I can verify them all.    I want to verify all the links
found in the Bookmark.htm Page List file.    Since the Bookmark.htm file is already selected, all I need 
to do is right-click on the tree and choose the Verify Links in this Page List option.    InfoLink then 
opens the file and verifies all the links.

If any of the links are broken, I can just open the Page List Manager, find the Bookmark.htm Page List 
file and delete the ones that were invalid or recheck them.    If I need to add a new URL to my 
Bookmark.htm Page List file, I use to the Add Link to Page List option in the Page List menu.

Description 2
The single site I had before has become much larger.    I now have the same pages as before, but I have
also created a shareware site that is hosted from the same domain as BiggByte.    I want to keep the 
original pages and my new shareware pages separate.    To do this, I need to create a new Page List for 



the shareware section of my site, but since it is from the same host, I should put it in the same Page 
Group as my original pages.    Therefore, I open the Page List Manager and find the BiggByteSite 
Group.    With the BiggByteSite Group selected, I create a new Page List and rename it to 
BiggByteShare.htm.    I then add all my shareware pages to the BiggByteShare.htm Page List.    Now 
that I have both lists finished, I can verify them one at a time or the whole Group just as before.

Description 3 - Tip on Creating Large Page Lists
All the above will work great but can be rather time-consuming at first.    Unfortunately there is no way of 
making it all happen very quickly, but there is a way to avoid typing in all the URLs one at a time.    To do 
this, you will have to add a new entry to the site list.    (See the Site List Manager for details.)    In the 
example we have now, I would add the BiggByte Site information to the site list.    Thus, I create a new 
entry and call it BiggByte Site.    Once I have the site entered in the Site List Manager,    InfoLink can 
download only the local pages in the site and save them to a Page List.    Depending on the size of your 
site, this could take a while, but it would still be much faster than entering all the URLs from the Page 
List Manager.    When creating a Page List from the Site List Manager, InfoLink stores the new Page List 
in the application's Files\SiteList directory.

So, I want to build a Page List but don't want to type in all the URLs from the Page List Manager.    I need
to open the Site List Manager and select the BiggByte Site entry that I just created.    With the 
BiggByte Site entry selected, in the options section, I need to uncheck the option Automatically Start 
Verification When Finished, check the option Save my site pages as this page list file, and enter a 
file name for my new Page List (remember to turn the option Automatically Start Verification When 
Finished option back on after InfoLink is finished).    I will call this file BiggBytePages.htm.    This file will
be saved in the application's Files\SiteList directory.    Now that I have everything set, I just click the 
Start button and let InfoLink find all my site's pages.

When InfoLink is finished, there will be a new Page List file called BiggBytePages.htm in the 
application's Files\SiteList directory.    Now I open the Page List Manager and add the 
BiggBytePages.htm Page List to the BiggByteSite group.    I do this the same as before, select the 
group and use the Add Page to Group menu option.    Now I have a new Page List in my BiggByteSite 
Group. 
I now need to get the links from the BiggBytePages.htm Page List to my two other existing Page Lists 
(BiggByte.htm and BiggByteShare.htm).    To do this, I select BiggBytePages.htm from the tree.    All 
of my site's pages appear in the contents window.    They are in sorted order, so it should be easy to find 
certain pages.    I scan the contents list looking for the pages that are not associated with the shareware 
part of my site.    I select each such page found using CTRL key and select it.    Once I have all my pages
for the BiggByteSite.htm Page List file selected, I drag and drop them on the BiggByteSite.htm item in
the tree.    When the pop-up menu appears, I select the Move Here option.    All of the links I have 
selected are added to that Page List and removed from the BiggBytePages.htm Page List.    

Now only my shareware pages are left in the BiggBytePages.htm Page List, so I select the 
BiggBytePages.htm Page List from the tree, and the links are displayed in the contents window.    I 
select them all, then drag and drop them on the BiggByteShare.htm Page List.    Now I have the same 
two Page Lists as before, and it took me considerably less time to create them.

That's it.



Site List Manager Description
The following is a detailed example of how to use InfoLink Link Checker's Site List Manager.    The Site 
List Manager is a very powerful tool that can greatly simplify the task of maintaining your Web sites.    
Read on to find out how you can verify entire sites with just two mouse clicks after entering basic 
site information on a one-time basis...

Though the descriptions below use only two Site List Files, everything in the examples would work the 
same with any number of Site List Files.

Site List Manager Examples

Adding New Sites
I have two Web sites to manage, neither of which is very large:    one has two sub-sites and hardly 
changes, the other has no sub-sites but changes nearly every week.    The first site, 
http://www.software.com/, is broken down into these 2 sub-sites http://www.software.com/games/ 
and http://www.software.com/business/.    The second site is http://www.biggbyte.com/.

First, I need to add each site to the Site List Manager.    I will start by adding the www.software.com 
site.    Since it has two sub-sites, I can have InfoLink treat each as though they are completely different.    
By doing so, I can keep my verification reports separate.    
The current Site List File is "sitelist.slf" (the default), and I will go ahead and use this instead of creating
another.    To add the first site, I choose the Add New Site option from the Site Tree menu, and a new 
site entry appears in the Tree.    Now I need to enter all the information about my site.    I want to 
separate the 2 sub-sites, so I will now enter the information for the first one (Games).    For the title of the
site, I enter "Software.com Sub-Site Games".    This will help me to identify it in the tree later.    In the 
starting URL, I enter the address of the Games Index Page, which is 
"http://www.software.com/games/index.html".    InfoLink will not retrieve any pages below 
"http://www.software.com/games/", so the Games sub-site will be kept separate from my other sub-
site.    I do want InfoLink to always automatically start verifying this site after it has found all the pages, so
I make sure the option Automatically Start Verification When Finished is checked.    However, I don't 
need to see the tree structure, so I uncheck the option Build Tree of the Site Being Verified.    In the 
"Save Results As" space, I need to enter a unique name for this sub-site.    I will enter "swcgames"    
for "Software.Com Games" and leave the extension as ".htm".    Now InfoLink will save my Verification 
Results as swcgames##.htm and my main Site List Report as "swcgames.htm".    Since this site 
doesn't change very often, I will not have InfoLink save it to a Page List.    I now have a new site entry in 
the list.

Next, I need to do the same for my second sub-site, "http://www.software.com/business/", so I go 
through the same steps as above.    I would enter as the Title "Software.com Sub-Site Business", 
enter the starting URL    "http://www.software.com/business/index.html", check the option 
Automatically Start Verification When Finished, uncheck the option Build Tree of the Site Being 
Verified, and instruct InfoLink to save results as "swcbusiness.htm".    Now I have two entries, one for 
each sub-site.

Next I want to add an entry for the whole site since from time to time, I may want to check it all at once.    
Once again I start by going through the first few steps outlined above, giving it a title, entering the 
Starting URL for this site ("http://www.software.com/"), and checking the option to tell InfoLink to 
automatically start verification.    However,    on this site I want to build a tree, so I check the Build Tree 
of Site being Verified option.    I want to save the results for this site as "swcsite.htm" for 
Software.com Site, and I want to save all the pages in this site, so I check the option "Save my sites 
pages as this page list" option and enter "swcpages.htm".    This will inform InfoLink to save all my 
pages to an HTML file called "swcpages.htm" and store it in the application's Files\SiteList directory.    
That is all I can enter at this time for this site.



I now have all the necessary information entered for my Software.Com site, so I can move on to the 
BiggByte Site (http://www.biggbyte.com/).    For this site, I will create a new Site List File; this way my 
two sites are completely separate.    I click the New Site List option from the Site List menu.    When the 
dialog appears, I enter BiggByte for the Site List File name.    InfoLink then creates a Site List File called
"BiggByte.slf", and an empty tree now appears in the Site List Manager.    I enter the site information 
just as before:    I enter for the title "BiggByte Site", the starting URL is "http://www.biggbyte.com/", I 
want to automatically start verification and build a tree, and finally, I opt to save my results as 
"biggbyte.htm".    Also, since this site    changes often, I create a Page List called 
"biggbytepages.htm", which will be saved to disk in the "Files\SiteList" directory and used later to 
decrease verification time.    

Verifying Your Sites
Now that I have both of my sites entered, I can start verifying them.    I want to verify my Software.Com 
Games site first.    My Software.Com site information is located in the Default Site List File "sitelist.slf",
so I open the Site List Manager and open the "sitelist.slf" if it is not already the current one.    (The 
current Site List File will always be displayed in the title bar of the window.)    Once the window is open, I 
select the Games ("Software.com Sub-Site Games") site entry from the tree.    All the information I 
previously entered fills the options fields.    All I need to do now is click the Start Button, and InfoLink will
verify that site.    When verification is finished, the InfoLink Report Viewer will open and display the Site 
Reports.    

To do the same for the Business Sub-Site, I select it from the tree and click the Start Button.    At any 
time before verification, I can changes the options of a particular site or the options of InfoLink.

After verifying my sub-sites and examining the Verification Reports, I want to verify the BiggByte Site.    I
open the Site List Manager and use the Site List menu to open the "BiggByte.slf" file, which I created 
earlier.    When opened, the site tree displays the BiggByte Site information.    Now I simply click the 
Start button.      When InfoLink finishes verifying the site, I get a new set of Verification Reports for my 
BiggByte Site.    

Now it has been a week since I have verified my sites.    Since my Software.Com Sites don't change 
often, I won't check them again yet. However, the BiggByte Site has changed in the last week, so I will 
need to check it again.    

Remember that when I entered the information for the BiggByte Site, I had InfoLink build a Page List 
from the pages found on the site and call it "BiggBytePages.htm".    I am now going to use that file to 
help verify the BiggByte Site.    I open the Site List Manager and make sure that "BiggByte.slf" is the 
current Site List File, as it contains the BiggByte Site information.    Then I select the BiggByte entry 
from the tree, and all its information appears.    I leave all the current information, but this time, instead of
having InfoLink scan my site by searching through the Internet for local pages, I will use the pages found
in the Page List "BiggBytePages.htm".    To do so, I check the option "Instead of downloading my 
site use this page list", and click the Ellipsis Button to display a window listing all Page Lists located 
in the "Files\SiteList" directory.    (You can also switch to the Files\PageList directory if the Page List 
you wish to use is located there.)    Page Lists will be listed only if you have previously had InfoLink build 
them from a site or if you have created them from the Page List Manager.    I now select 
"BiggBytePages.htm" from the list and click the OK Button.    InfoLink then returns me to the Site List 
Manager, and from there all I need to do is click the Start Button.    InfoLink will open the Page List, 
retrieve the pages from the file, and start verification as though it had scanned my entire Website.    
When InfoLink has finished verification, I get a new set of Verification Reports for my BiggByte Site.

Once all the relevant information is entered in the Site List Manager, clicking the Open List Button on 
the Main screen of InfoLink will display a pop-up menu containing a list of sites available for verification.   
This will allow you to open InfoLink and, WITH ONLY TWO CLICKS, VERIFY YOUR ENTIRE SITE.



The information above should give a good example of how to verify sites with InfoLink.    InfoLink allows 
you to manage your verification needs in several different ways.    (For more information on verifying 
pages, see the Page List Manager and the Page List Manager Description.)



Verifying a Page List
To verify a Page List with InfoLink, open the Page List Manager and select the desired page from the 
tree.    The Page List Manager allows you to verify any number of Page Lists or even an entire Page 
Group.    

After a Page List has finished verification, a set of Page List Reports are built that provide the 
information needed to correct any problems found in your pages.

To quickly verify a Page List, use the Open List button on the Main screen.    When you click this button, 
a pop-up menu appears containing an option called "Verify Page...".    Selecting a Page List from the 
menu list will automatically start verification of that Page List.

See Page List Manager Description for more information on verifying Page Lists.



InfoLink Link Checker 1.9 Help

Overview of InfoLink Link Checker 1.9

New features of Version 1.9

Verifying Links

Tips for Using InfoLink

Page List Manager and Page List Manager Description

Site List Manager and Site List Manager Description

InfoLink Editor

InfoLink Report Viewer and Verification Reports

Ordering Information



What's New in InfoLink Link Checker Version V1.9
With InfoLink 1.9, BiggByte Software has made available numerous new features that greatly increase 
program flexibility, while enhancing many previously existing features to make managing your Web sites 
even easier.

Here are some of the new features:
· New Interface - The latest Windows interface features.    New ways to get around InfoLink make

verifying a single page, an entire site, or even ten sites as easy as simply opening a file.
· Detailed Tree View - Lists each page verified, each link in each page, and each link's parent or 

parents to help track down problem areas.
· Page List Manager - Allows you to manage many different Page Lists rather than just one. Use 

it to manage many different Page List Files, each containing any number of Page Lists.
· Site List Manager - If you have ten sites to maintain, you can add them to the Site List Manager

or break them down in to separate Site List Files and manage each site separately.    Then, in 
just two clicks, you can verify any one of the sites.

· More User Control - More ways to control how links are verified.    New ways to filter links from 
being verified, Netiquette, and Password Protected Sites.

· New Page Links - Get quick verification information about your links as they are being verified.   
Lists about six different statistics for each link.

· New Link Information - Get detailed information about each link that was verified.
· New Page Information - Get information about the parent of any link that has been verified.
· New Report Generator - Build reports for both Page List and Site List.    As many as twenty 

different reports can be built.
· Some Reports Include

· Image view report shows all images in your site.
· Image statistics report.
· Image information and reference reports can help discover and correct any problems 

with your images.
· Link information and reference reports can help discover and correct any problems with 

your links.
· Link reports for finding possible problems in your site.
· Reports that show information about the servers your site links to.
· Page reports about all pages found in your site and any problems that occurred while 

trying to verify them.
· Download reports that show which pages are slow, fast, and average.
· Broken Link Reports.
· Report that shows what links have changed since your last verification.
· Verification Detail Report.    This report contains all the verification information you need 

to fix your links.
· Summary Report.

· New Report Viewer - View all reports from within InfoLink or in an external browser.
· Editor Enhancments - The new editor makes it simple to locate broken links and correct them.
· Correct and recheck links - After you have corrected any broken links in the InfoLink Editor, 

just click the Check Links option from the menu.
· Password Protect Page Support - Password protect pages can be accessed from both the 

InfoLink Main screen or the InfoLink Editor.
· All around enhancements - Many other new features.    Every feature of InfoLink has been 

upgraded to be more user- friendly and powerful.





Verifying Links
InfoLink Link Checker allows you to verify links in four different ways:    InfoLink can verify a single link at 
a time if you need to quickly check the validity of just one link, one page at a time to make sure that one 
new page that was just added to your site is all valid, a list of pages because there are times that you 
may not need to check your entire site, or your entire site for complete verification.

See Verifying Disk Files for information on verifying local files.

For examples on using the Verifying Page Lists and Sites, see Page List Manager Description and Site 
List Manager Description.

See What Links Will InfoLink Verify for more information.



Ordering InfoLink Link Checker
If you use InfoLink Link Checker regularly, you should seriously consider purchasing a registered 
version.    As a registered user of version 1.9, you will receive discounted prices on major upgrades and 
minor upgrades for free.

Ordering By Check or Money Order:
To order a copy of InfoLink Link Checker, please send a check or money order to:
BiggByte Software
P.O. Box 11603
Fort Smith, AR    72917
USA

By Credit Card: (Visa, MasterCard, American Express)
Please visit http://www.biggbyte.com/order.html for information on credit card orders.

Delivery of InfoLink is via the Internet.    Please include your e-mail address with all orders. Within 24-
48 hours of your order being processed, you will receive an e-mail from BiggByte Software informing you
of where to obtain the fullly functional version of InfoLink along with a registration number for your copy 
of InfoLink.

InfoLink has no printed user's manual.    Everything you need to use InfoLink will be in the help file.    Any 
other questions can be answered via e-mail.    Please allow al least 24 hours for a response.    If you do 
not receive a response within a reasonable amount of time, please send another, because BiggByte 
Software did not receive your message the first time.

Site License:    A site license for InfoLink Link Checker entitles an organization to receive one copy of 
the the registered version and redistribute it for a specified number of copies.

InfoLink Link Checker Prices:
1 InfoLink Link Checker V1.9 - $49.95
2 to 9 licenses at $40 each.
10 to 19 licenses at $35 each.
20 to 29 licenses at $30 each.
30 to ?? licenses at $15 each.

If necessary, please use this Order Form for your InfoLink Order.

For questions about ordering InfoLink, send e-mail to
order@biggbyte.com.
Send any comments about InfoLink via e-mail to
comments@biggbyte.com.

For more information or news about InfoLink, visit the BiggByte site at
http://www.biggbyte.com.

Please visit the BiggByte site as often as possible for new information about InfoLink.



InfoLink Link Checker 1.9 Order Form
Please include your e-mail address.
Without it, we have no way to inform you of where to obtain the registered version.

1    InfoLink    V1.9:    ____    license      at $49.95        = $______
02 to 09 licenses: ____    licenses at $40 each = $______
10 to 19 licenses: ____    licenses at $35 each = $______
20 to 29 licenses: ____    licenses at $30 each = $______
30 to ?? licenses: ____    licenses at $15 each = $______
Total    #    licenses: ____    Total    Cost    of    Order = $______                                                    

Name: _____________________________ Date:___________
                      
Company: __________________________________________
                                                                              
Address: ___________________________________________ 
                                                                              
City, State, Zip:______________________________________ 
                                                                              
Country:____________________________________________
                                      
Phone:_____________________________________________
                                                                        
E-Mail Address: _____________________________________
                                                                
How did you hear about
InfoLink Link Checker? ________________________________

Comments: _________________________________________



Editing Broken Links
The InfoLink Editor makes it simple to open an existing HTML file that has been verified and correct any 
of the broken links.

InfoLink stores all result information in an InfoLink Edit File (*.ief).    These files can be found in the 
application's Cache directory.    Each file contains information about the broken links found.    To open 
these files, use the Results List window.    InfoLink Edit Files are Not automatically deleted by InfoLink.    
You should not manually delete these files; instead use the Clear Disk Cache button in the 
General Preferences.    If the edit file is opened from the Results List, you can delete the cached edit file
by clicking the Remove button.

When an InfoLink Edit File is opened, you will be prompted to enter the location of the HTML file that 
contains the broken links.    Information displayed on the dialog shows where the file was originally 
located.    Once the location is entered, InfoLink will either open the file from disk or from the Internet 
depending on the location entered.    After the file is opened or downloaded, InfoLink displays it in the 
editor and fills the Broken Links List with any broken links found in that page.

The Broken Links List displays the Broken Link, its HTML Reference, and the associated error.    (The 
HTML Reference is how the link appears in your HTML.)    Each link is displayed with a broken link 
image (an image of a piece of paper with an "x" through it).    To find a broken link in the HTML file, 
select a broken link from the list and double-click on it.    InfoLink will find the location of the broken link, 
select the link in the editor, and change its color.    If the same broken link in the list is double-clicked 
again, InfoLink will search for another occurrence of that link.    If one is found, it will highlight that link.    
This should be continued until a dialog appears announcing that there are no more occurrences of that 
link to correct.    When this happens, the image associated with the Broken Link List item will change to a
corrected link image (an image of a piece of paper with a green check mark on it).



Opening Files from the Web
The InfoLink Editor allows you to open files directly from the Internet.    When the Open from the Web 
option in the File menu is selected, InfoLink prompts you for an address.    Only http and https files are 
supported.    After entering the location, InfoLink will attempt to download the page.    If the page is 
password protected, you will be prompted to enter that information.    Once the file is downloaded, it will 
be displayed in the editor.

When opening files from the Web in the InfoLink Editor, a button appears at the bottom of the window 
next to the Results List button.    This button can be used to stop the current file transfer.    If this button is
used, any part of the file that InfoLink has downloaded to that point is deleted and will not be displayed.

When a file is downloaded and displayed in the editor, it is not saved to disk.    If you need to keep
the file, you should use the File|Save As... menu option.



Frequently Asked Questions
Will InfoLink support frames?
Yes.    InfoLink Link Checker has full frame support.    InfoLink visually supports all frames found and 
provides ways to let you check the links one page at a time or all at once.    (See HTML Frames for more 
information on frame support.)

Why do I get a No Data Received from Server?
There are two reasons why this error might occur.

1.    When InfoLink tries to connect to a site and does so successfully, it sends the request to verify or 
retrieve the file.    InfoLink then waits a certain amount time, and if no information is sent back within that 
time period, this error is posted.    It simply implies that concern should be taken with this link or the 
server is not responding.

2.    The server sent a response that notified InfoLink that the file specified contained No Data to be 
received.    

Why do I need the Page List?
A Page List allows you to verify a set of pages at one time.    There may be times you don't need to verify
a complete site, so the Page List will allow a selected set of pages to be verified.    (See the Page List 
Manager and Page List Manager Description for more information.)

Will InfoLink Verify Files from Disk?
Yes.    Just open the file and click the Check Links button.    (See also Verifying Disk Files.)

How many Links will InfoLink Verify?
InfoLink has no limit to the number of links it can verify.    The number of links and files to verify in one 
process is limited to the resources offered by your system.    InfoLink will generate a file that is 
approximately 30K in size for every 100 links checked.    For example, if a page contains 500 links, the 
result file will be around 150K in size.    This will vary with the numbers of broken and valid links.    Result 
pages with more valid links tend to be larger due to additional information displayed for each successful 
link.    Turning off the option Include Successful Links in Results in the General Preferences will 
reduce the result file size .

Why does my Mailto link show no user found when it is valid?
In order for InfoLink to verify an e-mail address, the remote server must be set up to allow such 
verification.    When the server doesn't allow e-mail verification, InfoLink will return an error.    This option 
defaults to OFF in the Verification Preferences.

Why do I get a broken link when it actually isn't?
Some servers won't allow verification programs to access the site, which makes it difficult to check the 
validity of the link.    Other times, HTML syntax and Non-Standard code can cause a broken link.    If this 
occurs, first check the HTML syntax for possible errors. When making changes in HTML, it is easy to 
leave links and not realize it, especially when the page is large.    When InfoLink parses the HTML, it 
looks for anything that appears to be a link.    If you get a broken link and none of the above relates to 
you, please contact BiggByte Software at comments@biggbyte.com.    If possible, please include a 
URL that the links can be found.



Why does InfoLink say "Could Not Resolve Location"?
This error occurs when the specified link type could not be determined or is not supported.    When this 
error is received, check the link to ensure that it is syntactically correct.    One common mistake is to 
leave out part of the link.
Possible causes: 
http:/www.biggbyte.com - Notice the missing "/" after http:.
Attempting to open a non-existent file from disk.
Telnet Links.

I don't want to see successful links in my results.    How do I only get the broken links?
In the General Preferences window, turn off the option Include Successful Link in Results.    This will 
inform InfoLink to only track and list the broken links.    Turning off this option also helps by decreasing 
the size of the result file.

Can I use the Netscape Bookmark file for my Page List?
Yes.    With the new Page List Manager, you can add any HTML file to a Page List.    (For an example, 
see Page List Manager Description.)

Can I have more than one Page List?
Yes.    To have more than one Page List, just add the desired pages to the Page List Manager.

I have three sites.    How can I verify them all?
The Site List Manager allows you to add as many sites as you need.    Then simply selecting one of the 
sites will inform InfoLink to start verifying it.    You only need to enter each site's information once, and 
from then on, you can verify one of the sites with as little as two mouse clicks.

Can I view my results in another browser rather than in InfoLink?
Yes.    After verification has completed, all results are listed in the Errors and No Errors tab.    Clicking the 
Open in Browser button will inform InfoLink to open the results in browser specified in the General 
Preferences.    (See also Viewing Results.)

I need to add the verification information to a database.    How can I do this with InfoLink?
As InfoLink verifies pages, a result file in HTML format is built.    These results contain all the information 
InfoLink uses to build Verification Reports.    Each result file has an HTML comment (<!- ->) listed at the 
bottom of the file.    All the verification information is listed within these comments in comma-delimited 
form.    Read this information within the comments to get the verification information.



Verifying Disk Files
Verifying An HTML File From Disk
To verify a file on disk, open the file with the File|Open File menu option and select the file that you want 
to verify.    InfoLink Link Checker checks for a Base Link, and if one does not exist, you will be prompted 
to enter it in the Base Link window.    Canceling out of this window will cause InfoLink to retrieve the links 
without a Base Link (see Determining Base Links).    If there are local links in the file, an error will be 
displayed in the result page after those links are verified.    If a Base Link does exist, InfoLink proceeds 
normally:    InfoLink reads the file from disk, retrieves the links, displays them in the list box, and displays 
the file in the browser.    

To start verification, select the links you want to verify and click the Check Links button.    If no links are 
selected, then all links are assumed.    InfoLink will test all links selected and return results in the InfoLink
Browser.    Each time links are checked, a result page is generated and timestamped at the bottom for 
future use.    Each link has its own status, and the results allow you to jump to the successful links or to 
the failed links.    

In the General Preferences window, you can specify whether or not to include successful links in the 
result page.
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Base Link
When verifying a file from disk, InfoLink treats the file as though it is on the Internet.    In order to do this, 
InfoLink needs a way to interpret any relative link in the HTML document.    When prompted for a Base 
Link, you should enter the URL under which the page can be found on the Internet.



Changed Link Index
A file created by InfoLink which allows for detecting changes in your site when building Site Reports.    
This report can be viewed in the InfoLink Report Viewer.



Frame Information Page
An HTML file generated by InfoLink Link Checker of all frames found and any frames found in those 
frames and so on.    This file is displayed when a page with frames is encountered to allow each frame to 
be verified one at a time or to allow them to all be verified at once.



Frame Result File
A file created by InfoLink after verifying a set of pages.    This file can be opened in an external browser to 
view the last set of Verification Results created.    The browser must support frames in order to open this 
file correctly.    The file is saved in the application's Results directory as "resultframe.htm".



InfoLink Comment
A comment inserted at the top of an HTML file by InfoLink Link Checker to help determine the location of 
relative links.    This is the same as the HTML <BASE HREF> tag.



InfoLink Edit File
A file that contains all information needed by the InfoLink Editor to open and display the HTML file and 
any broken links found within it.



Link List File
When a list of links are displayed in the links list box of the Main screen, right-clicking on the mouse will 
pop up a menu with a Save Links As... option.    Selecting this option will allow you to save the links to a 
text file.    This file can be added to a Page Group in the Page List Manager or opened in the InfoLink 
Main screen and verified.



Page Group
A Page Group serves as a parent of any number of Page Lists.    This allows you to select pages from the 
Group and verify only those, or to select the Group and verify all pages within it.



Page List
An HTML file that contains a list of pages that need to be verified.    A Page List is comprised of pages that
will be listed under a Page Group.    This information is found in the Page List Manager.



Page List File
A file created by InfoLink that stores information about any number of Page Lists and Page Groups that 
need to be managed.    This information is used by the Page List Manager.



Result File
A file displayed in the InfoLink Browser with information about the status of the links checked.    This file is 
in the format of "filename##.htm".    These files will be listed in the Errors and No Errors listbox on the 
Main screen of InfoLink Link Checker.



Set of Pages
Used to reference all pages being verified from the Page List Manager or all pages found in your site 
when verifying from the Site List Manager.



Site List File
A file created by InfoLink that stores information about any number of sites that need to be managed.    
This information is used by the Site List Manager.



Verification Report
A detailed report generated by InfoLink after a Page List or a Site has been verified.    These reports can 
be viewed in the InfoLink Report Viewer.



Verification Results
Result files that are displayed in the InfoLink Browser.    These files are supplied regardless of verification 
type.    When a set of pages is being verified, these files can be opened in an external browser by clicking 
the Open In Browser button on the Main screen.    When only a single page or a single link is being 
verified, the file is stored in memory until saved to disk.    In this case, the Open In Browser button is 
unavailable.






